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سخن ناشر    
 

 «ن والقلم و ما یسطرون»

 کلمه نزد خدا بود و خدا آن را با قلم بر ما نازل کرد.

به پاس تشکر از چنین موهبت الهی، موسسه ماهان درصدد برآمده است تا در راستای انتقال دانش و مفاهیم با کمک اساتید 

شما داوطلبان ادامه تحصیل در مقطع کارشناسی ارشد گام موثری بردارد. امید مجرب و مجموعه کتب آموزشی خود برای 

 های بلند فردای شما باشد.  گذار گام های خدمتگزاران شما در این موسسه پایه است تلاش

د. ان منظور استفاده داوطلبان کنکور کارشناسی ارشد سراسری و آزاد تالیف شده های کمک آموزشی ماهان به مجموعه کتاب

های متعدد در   گیری از تجربه اساتید بزرگ و کتب معتبر داوطلبان را از مطالعه کتاب ایم با بهره ها سعی کرده در این کتاب

 نیاز کنیم.  هر درس بی

 باشد. صورت ذیل می دیگر تالیفات ماهان برای سایر دانشجویان به

مرحله آزمون تالیفی  3سال اخیر به همراه  5ارشد مرحله کنکور کارشناسی  5شامل  آزمون:  8های  مجموعه کتاب ●

ها با  باشد که برای آشنایی با نمونه سوالات کنکور طراحی شده است. این مجموعه کتاب ماهان همراه با پاسخ تشریحی می

سی در ریزی در بندی مباحث در هریک از دروس، اطلاعات مناسبی جهت برنامه ساله اخیر کنکور و بودجه 3توجه به تحلیل 

 دهد. اختیار دانشجو قرار می

روزرسانی تالیفات ماهان  وسیله از مجموعه اساتید، مولفان و همکاران محترم خانواده بزرگ ماهان که در تولید و به بدین

 نماییم.  اند، صمیمانه تقدیر و تشکر می نقش موثری داشته

شنهاد درخصوص تالیفات ماهان را از طریق سایت ماهان به آدرس توانند هرگونه انتقاد و پی دانشجویان عزیز و اساتید محترم می

mahan.ac.ir .با ما در میان بگذارند 

 

 موسسه آموزش عالی آزاد ماهان

 

 

 



 

سخن مؤلف    
 سپاس بی کران پروردگار یگانه را سزاست  که ما را خلعت خلقت بیاراست و توفیق خدمت گزاری بر بندگانش ارزانی فرمود.

 شناخته  Teaching English as a Foreign Language یا  TEFLی تحت عنوان رشته آموزش زبان انگلیس

نیز گفته می شود.با توجه  به بین المللی شدن زبان   Applied Linguisticsمی شود، که در سطح جهانی به آن 

تثنا از این روند نیست. انگلیسی، علاقمندان به یادگیری این زبان روز به روز در حال افزایش هستند که کشور ایران نیز اس

همزمان، این روند موجب شده که متقاضیان زیادی به آموزش زبان انگلیسی علاقمند شوند که این امر رقابت در این رشته را 

دریس در کنکور کارشناسی ارشد، در این کتاب سعی شده است مطالب دشوار کرده است. به دلیل اهمیت درس روش های ت

مهم کنکوری به طور کامل از کتاب های مرجع گردآوری شده و در مجموعه ای منسجم در دسترس داوطلبان  قرار گیرد. 

که  کتاب حاضر شامل دو فصل اصلی می باشد که هر فصل دربرگیرنده ی سرفصل های مهم و طبقه بندی شده ای است

منبعی خوب و روان برای مرور بر تمامی مطالب مورد نیاز متقاضیان  آزمون محسوب می شود. هم چنین در پایان هر 

سرفصل، سوالات تالیفی جهت ارزیابی فهم مطالب درسی ارائه شده است. در پایان کتاب حاضر، سوالات کنکوری برگزار شده 

یحی قرار داده شده است. امید است که متقاضیان بتوانند از این کتاب بهره به همراه پاسخ نامه تشر 1400تا  1391از سال 

 ی کافی را ببرند و مسیر موفقیت آنها تسهیل شود.

صمیمانه سپاسگزاری میکنم که اگر همکاری و دلگرمی ایشان نبود، هرگز این اثر به زیور طبع آراسته  در خاتمه از همسرم

 نمی گردید. 
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SECTION ONE: Language and Learning 

Introductory Concepts in Applied Linguistics 

0. Introduction > Applied linguistics (AL) as a field of study has been narrowed down 

to teaching English as a foreign language (TEFL) and teaching English as a second 

language(TESL), dealing with two major aspects which are totally interrelated. 

 Theory > Language, Learning, Teaching 

 Practice> Methodology, Materials, Testing and Assessment 

Given that all fields are interdisciplinary and intertwined, we seek to understand     

how the practical aspects of teaching have changed, according to the theoretical 

models of language and language use. 

 

1. Language, Learning and Teaching 

 Language: 

 Systematic and Rule-governed 

 Universal Means of Communication 

 Mainly Oral/Aural or Verbal/Spoken 

 Locally Conventionalized 

 Species-specific 

 Creativity and Duality 

 

 Learning: 

 Acquiring Some Skills or Knowledge 

 Developing Relatively Permanent Change in Behavior 

 Occurring Due to Reinforced Practice 

 

 Teaching: 

 Teacher as Source of Knowledge (Traditional View) 

 Teacher as a Co-Learner and Facilitator (Modern View) 

 Teacher Helps, Instructs and Guides Learner (Comprehensive View) 
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Main Concepts of Language Learning 

 

1. Competence vs. Performance > The emphasis on these concepts varies in different 

doctrines.  

 

 Behaviorism and Structuralism > The emphasis is on performance. 

 Cognitivism and Nativism > The emphasis is on competence. 

 Constructivism and Post Structuralism > The emphasis is on both performance and 

competence. 

 

2. Comprehension vs. Production > Both production (creation) and comprehension 

(recreation) have both a competence and a performance. 

 

3. Nature vs. Nurture > Since these two concepts are related to innateness and 

environment, respectively, the emphasis on them varies in different doctrines.  

 

 Behaviorism and Structuralism > Nurture 

 Cognitivism and Nativism > Nature 

 Constructivism and Post Structuralism > Both Nature and Nurture 

 

4. Systematicity vs. Variability > A learner language (Interlanguage) is both systematic 

and variable. 

 

 Systematicity > An interlanguage is stable, rule-governed and meaningful at 

least to the learner. 

 Variability > An interlanguage is dynamic, changing from learner to learner 

and within a learner over time. 

 

5. Language and Thought > Four main views exist regarding the relationship between 

these two concepts. 

 

I. No Relationship: Behaviorists did not believe in the power of thinking. 

II. Thought > Language: Figures such as Chomsky, Piaget and Ausubel believed 

that thought influences language. 

III. Language > Thought: Figures such as Vygotsky and Oller believed that 

language influences thought. 

 Sapir-Whorf Hypothesis: Linguistic Thought 



 

 

 

 

Language and Learning 9 

 Linguistic Determinism (strong version) > Whorf believed that 

language determines thought. 

 Linguistic Relativity (weak version) > Sapir believed that language 

influences thought. 

IV. Thought < > Language: Figures such as Wardhaugh believed that both 

language and thought influence each other. 

 

6. Imitation > Behaviorism overemphasized immediate imitation called echoing 

(meaningless), whereas Vygotsky highlighted deferred imitation in the learner’s 

private speech leading to internalization (meaningful).  

 

7. Practice > Salience (meaningfulness of practice) matters more than frequency (the 

amount of practice). 

 

8. Input > There are two dichotomies in terms of input. 

 

 Positive Evidence vs. Negative Evidence > The former refers to correct 

instances of language use we receive while the latter refers to corrective 

feedback on errors. 

 Type vs. Token > The former refers to the class of linguistic feature (general 

category), while the latter refers to the individual members of the class 

(particular instances). 

 

9. Discourse > Without output, input will be insufficient for acquisition to occur. 

 

 The Output Hypothesis (Swain) > It emphasized the role of output. 

 The Interaction Hypothesis (Long) > It emphasized the role of interaction. 

 

10. Types of Learning > According to Gange, there are eight types of learning. 

 

 The first five types are in accordance with behaviorism. 

i. Signal Learning > Pavlov’s classical conditioning (learning through 

imitation). 

ii. Stimulus Response Learning > Skinner’s operant conditioning 

(learning through reinforcement). 

iii. Chaining > A chain of several stimulus-response connections. 

iv. Verbal Association > Learning of chains that are verbal. 

v. Multiple Discrimination > Learning to make different responses to 

different stimuli. 
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 The second three types are in accordance with cognitivism, humanistic 

psychology and constructivism. 

vi. Concept Learning > Learning to make a common response to a class of 

stimuli. 

vii. Principle Learning > Learning a chain of several concepts (Ausubel’s 

meaningful learning) 

viii. Problem Solving > Learning through creative thinking, inferencing and 

intuition, which involves the interaction of all eight types of learning. 

 

11.  Transfer > It can be defined as the carryover of prior knowledge to subsequent 

learning, which is of two types. 

 Positive Transfer > The prior knowledge benefits the learning task. 

 Interlingual:  /پ /  → /p/ 

 Intralingual: talked → walked  

 Negative Transfer > The prior knowledge disturbs the subsequent learning. 

 Interlingual (Interference): یک معلم خوب → a teacher good 

 Intralingual (Overgeneralization): talked → goed 

 

12.  Language Aptitude > It refers to the natural ability to learn a language. Language 

aptitude tests (measuring one’s aptitude for SLA or FLA) are of two types: 

 Traditional Tests > They were usage-based, measuring aspects such as sound 

coding, grammatical coding, inductive learning, memorization and cognitive 

analytic abilities. 

 Modern Tests > They are use-based, measuring aspects such as chunking, 

inductive learning, processing speed, pragmatics, self-efficacy and retrieval 

abilities. 

 Dynamic Systems Theory (DST) > It is a combination of claims, based on 

chaos-complexity theory (SLA is a dynamic, complex, nonlinear and 

unpredictable process). 

 Aptitude-Treatment Interaction > The students’ level of achievement can 

be enhanced through the appropriate methodology (treatment) chosen 

based on their learning styles (aptitude). 

 

13.  Intelligence > Due to the introduction of some parameters including subsumption 

ability, the view of intelligence has changed a lot. 

 Traditional Westernized View vs. Gardner’s Multiple Intelligences Model > 

The former was culture-bound, only dealing with logical/mathematical 
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analysis and verbal competency, while the latter is culture-free, dealing with 

nine forms of intelligence. 

 

 Gardner’s Multiple Intelligences Model (MI) > Each individual enjoys 

different types of intelligences, according to which instruction should be 

planned.  

 

1. Linguistic/Verbal Intelligence (remembering written and spoken 

information) 

2. Logical/ Mathematical Intelligence (analyzing situations or problems 

logically to identify solutions)   

3. Spatial/Visual Intelligence (recognizing patterns easily) 

4. Rhythmic/Musical Intelligence (creating rhythmic patterns, humming 

and singing in a group) 

5. Bodily/Kinesthetic Intelligence (having excellent physical coordination) 

6. Interpersonal/Social Intelligence (establishing rapport with strangers and 

making friends easily)   

7. Intrapersonal Intelligence (being aware of their own emotional states, 

feelings and motivations) 

8. Naturalistic Intelligence (excelling in growing plants and taking care of 

animals)  

9. Existentialist Intelligence (looking beyond the senses to explain 

phenomena) 

 

 Sternberg’s Triarchic View of Intelligence > It is one of the thought-

provoking theories. 

 

1. Componential Ability (Analytical Thinking) 

2. Experiential Ability (Creative Thinking) 

3. Contextual Ability (Street Smartness) 

 

 Oller’s Language-Based View of Intelligence > Linguistic development 

contributes to intelligence increase. 

 

 Goleman’s Emotional Intelligence (EQ) > Knowing and controlling our 

emotions and those of others facilitates making logical decisions in critical 

situations. 

 

 Wagner and Sternberg’s Three Conceptions of Intelligence 

i. The Psychometric view > It equates intelligence with mental capacity 

which is measured through prepared tests (the brain’s capacity). 

ii. The Piagetian View > It defines intelligences in terms of cognitive 

development and life experience (the brain’s capacity). 

iii. The Information-processing View > It focuses on how the brain 

processes information (what the brain does during processing). 
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Mock Items 
 

 

1- Pronouncing the word doctor as /dɔktɔr/ by a Persian native speaker learner of 

English is an instance of ………… .  

1) positive transfer  2) generalization 

3) interference  4) negative intralingual transfer 

2- According to Gagne’s learning types, learning the pronunciation of a word through 

mere listening is an example of ………… .  

1) signal learning  2) stimulus-response learning 

3) multiple discrimination 4) verbal association 

3- When an L2 learner automatically adds past simple –ed to the verb point, which he 

has just learned, an instance of ……… has occurred.  

1) positive interlingual transfer 2) overgeneralization 

3) interference  4) intralingual transfer  

4- Learning to make a number of different identifying responses to many different 

stimuli, which may resemble each other in physical appearance to a greater or lesser 

degree, is referred to as ……… in Gagne’s learning types.  

1) chaining  2) concept learning 

3) multiple discrimination 4) principle learning 

5- Pronouncing the words hit and heat both as /hi:t/ is an instance of ……… for a 

Persian learner of English as a second language.  

1) positive transfer  2) interference 

3) overgeneralization  4) intralingual transfer 

6- Based on the triarchic view of intelligence, ………refers to the ability for creative 

thinking, intuitive actions, and inferencing.  

1) componential ability 2) experiential ability 

3) contextual ability  4) logical-mathematical ability 

7- According to Gagne’s classification of learning types, acquiring a precise response to 

a discriminated stimulus is referred to as ……….  

1) concept learning  2) signal learning 

3) stimulus-response learning 4) verbal association 

8- All of the following are elements of Long’s interaction hypothesis except……….  

1) negotiation of meaning 2) focus on form 

3) output  4) elaboration 

9- According to Gagne’s learning types, ……… refers to the learning of chains that are 

verbal such as in alphabet games. 

   1) signal learning  2) stimulus-response learning 

   3) verbal association  4) multiple discrimination 
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10- The acquisition of the order adjective+noun for a Persian native speaker learner of 

English as a second language may represent an instance of ……… . 

   1) positive interlingual transfer 2) positive intralingual transfer 

   3) interference  4) overgeneralization 

11- Self-esteem journals and individualized projects are activities to enhance the ……… 

in multiple intelligences. 

   1) intrapersonal intelligence 2) linguistic intelligence 

   3) logical intelligence  4) kinesthetic 

intelligence 
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Explanatory Answers 

 

 

1- Choice (3) 

Refer to: PLLT, chapter 4 

2- Choice (1) 

Refer to: PLLT, chapter 4 

3- Choice (4) 

Refer to: PLLT, chapter 4 

4- Choice (3) 

Refer to: PLLT, chapter 4 

5- Choice (2) 

Refer to: PLLT, chapter 4 

6- Choice (2) 

Refer to: PLLT, chapter 4 

7- Choice (3) 

Refer to: PLLT, chapter 4 

8- Choice (4) 

Refer to: PLLT, chapters 2, 4, & 10 

9-Choice (3) 

Refer to: PLLT, chapter 4 

10-Choice (3) 

Refer to: PLLT, chapter 4 

11-Choice (1) 

Refer to: R&R, chapter 12 
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The Relationship Between Age and Language Learning 

 

1. The Critical Period Hypothesis (CPH) > It refers to a biologically determined period 

of life when the first language can be acquired effortlessly. 

 Lateralization > The localization of cognitive functions occurs in different 

parts of the brain due to aging.  

 Strong Version > The ability to acquire one’s L1 is lost at a specific point in 

time. 

 Weak Version > The ability to acquire one’s L1 is lost over a period of time. 

This version is also called the Sensitive Period Hypothesis (SPH). 

 

2. Linguistic Considerations > It considers the cognitive aspects of language, aging and 

learning. 

 Bilingualism > It is of two kinds. 

i. Coordinate Bilingualism > Two separate meaning systems in 

individuals’ minds (more problematic code-switching for adults). 

ii. Compound Bilingualism > One unified meaning system in individuals’ 

minds (less problematic code-switching for children).  

 Heritage Language Acquisition > Family lineage languages 

acquired slowly by bilingual children. 

 Interference > If adults cannot generalize within L2, they may transfer L1 rules 

negatively. 

 Order of Acquisition > It refers to the creative construction of L2 rules by 

applying certain strategies, as proposed by Dulay and Burt (Creative 

Construction Hypothesis). 

 It signifies avoiding using the rules of L1 in learning L2 and making 

the rules of L2 creatively. 

 

3. Affective Considerations > It considers the affective aspects of human beings, aging 

and learning. 

 Egocentricity > The lower the age and cognition, the lower the sense of self-

identity, as a result of which, children’s ego eccentricity is higher (a child's 

inability to see a situation from another person's point of view). 

 Inhibition > The higher the age and cognition, the higher self-identity, as a 

result of which, adults’ protective distance is higher (inhibition discourages 

risk-taking, which is necessary for progress in language learning). 

 Considering this fact, children learn a language more effortlessly than 

adults.  
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 Language Ego > It defines the relation between individuals’ self-identity and 

facets of their language (language ego is when learners develop a new mode of 

thinking, feeling, and acting). 

 As L1 ego is strong, it leads to thin and permeable inhibition. 

 As L2 ego is fragile, it leads to thick and impermeable inhibition, 

triggering defensive learning. 

 Defensive learning causes less participation and communication and 

more inhibition on the part of the learner. 

 

 Attitude > Positive attitudes towards a specific language and its speakers 

facilitate language learning, while negative attitudes hinder it. 

 Attitudes are less problematic for children due to the absence of strong 

attitudes. 

 Peer Pressure > It refers to encouragement to conform to others’ behavior, 

attitudes, language, etc. 

 Being more competitive, children experience more peer pressure 

interrupting L2 learning. 

 Being more tolerant, adults experience less peer pressure, simplifying 

L2 learning. 

  



 

 

 

 

Language and Learning 17 

 

Mock Items 
 

1- ……… is referred to the separateness of the learning contexts of the two languages 

for the individual. In this case the individuals will retain two meaning systems in their 

minds, the two systems being separate.  

1) Coordinate bilingualism 2) Compound bilingualism 

3) Code-switching  4) Language ego 

2- In ………, which is a cause of language attrition, L2 is dominant and this situation is 

prevalent in ESL contexts.  

1) compound bilingualism 2) subtractive bilingualism 

3) additive bilingualism 4) coordinate bilingualism 

3- Lateralization, which is defined as the localization of cognitive functions in different 

parts of the brain as a result of aging, is believed to be the main reason of ………… . 

   1) the critical period     2) egocentricity  3) peer pressure    4) elaboration 

4- In this type of bilingualism, there are two separate meaning systems for the two 

languages in the mind of the language user. 

   1) Additive    2) Coordinate          3) Compound              4) Subtractive 

5- Which aspect of second language acquisition is most probably negatively affected by 

the critical period? 

   1) Syntax 

   2) Lexicon and knowledge of morphemes 

   3) Production of sound units and prosodic elements 

   4) Semantic and pragmatic abilities 
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Explanatory Answers 

 

 

1- Choice (1) 

Refer to: PLLT, chapter 3 

2- Choice (2) 

Refer to: PLLT, chapter 4 

3-Choice (1) 

Refer to: PLLT, chapter 3 

4-Choice (2) 

Refer to: PLLT, chapter 3 

5-Choice (3) 

Refer to: PLLT, chapter 3 
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The Relationship Between the Brain and Language Learning 

 

1. Cognitive Considerations > It considers the cognitive aspects of human beings, 

aging and learning. 

 Cognitive Development > Social interaction only triggers this development, 

starting from birth to puberty. 

 Piaget’s Three-Stage Intellectual Development in a Child 

i. Sensorimotor Stage > Being capable of perceiving the world 

only through basic senses (birth to two; an infant sees a toy car 

under the kitchen table and then crawls, reaches, and grabs the 

toy). 

ii. Preoperational Stage > More organized action, thought, mind 

flexibility, ignition of memory and imagination (two to seven; 

a child uses symbols to represent words, images, and ideas). 

iii. Operational Stage > Internalized action as a part of child’s 

knowledge and skills, including two stages: 

 Concrete Operational Stage > Being capable of 

transacting beyond the given information, they learn 

that actions can be reversed (seven to eleven; one 

begins to understand that their thoughts are unique to 

them and that not everyone else necessarily shares their 

thoughts, feelings, and opinions). 

 Formal Operational Stage > Being capable of 

abstraction, formal thinking and indirect perception, 

they transcend concrete experiences and direct 

perception (eleven to sixteen; one develops an ability to 

systematically plan for the future and reason about 

hypothetical situations). 

 Equilibration > It refers to a balance between prior and new knowledge, i.e., 

the progressive interior organization of knowledge in a stepwise fashion. 

 Cognitive development (maturation) is a process of moving from 

states of doubt (disequilibrium) to states of certainty (equilibrium). 

 Cognitive adaptation consists of two phases, leading to maturation. 

i. Assimilation / Subsumption > New information is modified in 

our minds so that we can fit it with our prior information (a 

child sees a new type of dog that they have never seen before 

and immediately points to the animal and says, "Dog!). 
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ii. Accommodation / Restructuring > Prior information is 

modified in our minds so that we can keep in mind new 

information (a process by which learners change their 

interlanguage systems). 

 

2. Neurological Considerations > It considers the brain’s function in language 

learning and language use. 

 Hemispheric Lateralization > This process starts at birth and finishes around 

puberty. 

 Critical period applies to L1, while in learning L2 only the native-like 

accent is affected. 

 Biological Timetables and Predisposition > A critical period for the languages 

of birds exists. 

 Scovel’s Sociobiological Critical Period > There is a biological 

timetable for the accents of birds due to two reasons: 

i. Identifying with Other Birds in Their Flocks > It applies 

to human beings, since we cannot acquire L2 accent 

after puberty. 

ii. Attracting Other Birds for Mating > It does not apply to 

human beings, since we humans even marry people 

speaking other languages. 

 Walsh and Diller Hypothesis > There is a biological timetable for the language 

acquisition. 

i. Higher-order (Complicated) Process > Morphology and 

syntax are easier to learn after puberty. 

ii. Lower-order (Uncomplicated) Process > Accent and 

pronunciation are more difficult to acquire after puberty. 

 Right-hemispheric Participation > The brain loses its flexibility after puberty. 

 Children can acquire language through devising both 

hemispheres. 

 Adults can acquire language through their left hemisphere. 

 Anthropological Evidence > People can remove the biological barriers due to 

sociocultural and attitudinal motives. 

 The Significance of Accent > What matters today is a comprehensible accent 

rather than an authentic pronunciation. 
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3. The Brain’s Operations > They are of three types. 

i. Primal > Performing needed functions subconsciously (problem solving, 

memory, language, judgment, impulse control, and reasoning). 

ii. Emotional > Being able to feel (controlling and processing emotions). 

iii. Rational > Processing ideas and producing language consciously (analysis, 

sensory processing, learning, memory, motor control, decision-making and 

reasoning). 

 

4. Different levels of Mental Activity > They are of three levels. 

i. Conscious/Rational Processing > Deep thinking. 

ii. Subconscious/Automatic Pilot > Without deep thinking. 

 Controlling basic bodily functions 

 Routine and skilled activities 

 Creative and problem-solving tasks 

iii. Metacognition > Management, Monitoring and Evaluation. 

 Predicting performances and results 

 Evaluating results 

 Monitoring ongoing activities 

 Testing the reality of something 

                          → Wagner and Sternberg’s Four Areas of Weakness: 

a. Assessing difficulty 

b. Assessing comprehension 

c. Assessing content significance and strategy effectiveness 

d. Predicting performance 

 

5. Different types of Mental Activity > They are of two types. 

i. Algorithmic > Following a learned procedure 

ii. Heuristic > Exploring and discovering a new procedure 

 

6. Processing information > There are two ways of reasoning. 

 Deductive Reasoning > It is a movement from rule (abstract) to example 

(concrete) → Usage-based Learning and Teaching (Deductive reasoning 

moves from generalities to specific conclusions). 

 Inductive Reasoning > It is a movement from example (concrete) to rule 

(abstract) → Used-based Learning and Teaching (drawing a general 

conclusion from a set of specific observations).  

 Gestalt Theory (theory of the whole) > It is based on the idea of closure 

(the sum of the parts does not equal the whole), emphasizing holistic 

learning. 
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7.  Types of Knowledge in The Brain > They are of two types. 

 Declarative / Explicit knowledge > It is our theoretical information which is 

verbalized (the prior knowledge) > Facts, world history, or rules for 

mathematical equations are all examples of declarative knowledge, meaning 

that you are consciously aware that you understand the information. 

 Procedural / Implicit Knowledge > It is our practical information which is 

fluent (the learning skills and strategies) > Learning how to ride a bicycle, 

learning how to use a computer keyboard, or even learning the skills 

necessary to play a musical instrument are all examples of procedural 

knowledge, which is attained by practicing or exercising a task or a skill. 

 

8.  Anderson and Dekeyser’s Three Stages of Skills Acquisition 

 Cognitive > It deals with declarative knowledge (forming an image through 

observation). 

 Associative > It deals with procedural knowledge (developing a method 

through practice). 

 Autonomous > It means doing the skill automatically. 

 

9.  Memory > The preparation of long-term memory is done by short-term memory 

(also called the working/speech-processing memory), which is conscious and 

capacity-limited. This occurs through two phases: 

i. Rehearsal > Holding information for elaboration. 

ii. Elaboration > Chunking information for subsumption. 

 

10.  Schemata and Scripts > The former refers to large blocks of information in the 

form of general categories (Schemata are determined by one's self-knowledge and 

cultural-political background, including rubrics, perceived social roles, stereotypes, 

and worldviews). However, the latter refers to procedural schemata, helping us to 

predict sequences of actions in familiar situations (We have scripts for what 

normally happens in all kind of events, such as going to a doctor's office, a movie 

theatre, a restaurant, or a grocery store). 

 

11.  MURDER > It refers to an information-processing approach to reading in order to 

boost students’ metacognition skills. 

 M > Getting oneself into the mood 

 U > Understanding your general goal 

 R > Recalling content  

 D > Digesting materials 

 E > Expanding knowledge 

 R > Reviewing mistakes 
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Mock Items 
 

 

1- It is the learning skills and strategies that individuals have acquired during their 

lifetime from their learning experiences.  

1) Declarative knowledge 2) Data-driven processing 

3) Procedural knowledge 4) Algorithm 

2- It is at this stage of skill acquisition that the individual forms an image of the skill in 

the mind. 

1) Procedural 2) Cognitive 3) Autonomous 4) Associative 

3- According to this level of operation by the brain, ………operations enable humans to 

perform needed functions at a sub-conscious level while freeing the brain to concentrate 

on other processes that require conscious attention.  

1) primal 2) emotional 3) rational 4) associative 

4- This level of the brain operations enables humans to perform the needed functions at 

a sub-conscious level while freeing the brain to concentrate on other processes that 

require conscious attention. 

   1) Primal operations  2) Metacognitive operations 

   3) Rational operations  4) Emotional operations 

5- It refers to a stage of skill acquisition at which the individual is able to perform the 

skill automatically. 

   1) Cognitive    2) Associative 3) Autonomous 4) Declarative 

6- ……… is NOT among the four key principles at the heart of Neurolinguistic 

Programming. 

   1) Rapport  2) Outcome 3) Sensory acuity  4) Whole person 

7- It is the learning skills and strategies that individuals have acquired during their 

lifetime from their learning experiences. It is actually our automatized/practical 

information. 

   1) Procedural knowledge 2) Declarative knowledge 

   3) Algorithm  4) Heuristics 

 

  



 
 
 

 
 

 

Methodology of Teaching 24 

 

Explanatory Answers 

 

 

1- Choice (3) 

Refer to: Chastain, chapter 2 

2- Choice (2) 

Refer to: Chastain, chapter 2 

3- Choice (1) 

Refer to: Chastain, chapter 2 

4-Choice (1) 

Refer to: Chastain, chapter 2 

5-Choice (3) 

Refer to: Chastain, chapter 2 

6-Choice (4) 

Refer to: R&R (ed.2), chapter 11 

7-Choice (1) 

Refer to: Chastain, chapter 2 
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Main Doctrines of Language Learning 

 

0. Introduction > Science is the result of conducting systematic research, leading to 

different schools of thoughts. The background of each school reflects its general view 

of science. As science changes, so do the humanities, including AL. Therefore, in each 

school we examine background, learning and language to determine the status of 

science, humanities and AL in that school, respectively. 

 Background > Science 

 Learning > Humanities 

 Language > Applied Linguistics 

     Four doctrines are examined with the focus on these three components. 

 

1. Traditional Era 

1.1 Background: Traditional Rationalism 

 Pre-scientific Period > There was no room for research. 

 Mentalism > Logic and hunches were the sources of science. 

 Armchair Speculation > Theories were not tested. 

 

1.2 Learning: Faculty Psychology 

 “Practice makes perfect” maxim > Brain is like a muscle. 

 Grammar-Translation Approach > Analysis and memorization were the main 

way of learning. 

 German Scholarship > Rules and formulas mattered rather than ability to use. 

 Traditional Humanities > Absolutism was emphasized and errors led to 

imperfections. 

 

1.3 Language: Prescriptivism 

 Prescriptive Grammar > There was an ideal form of language. 

 Traditional Linguistics > Latin was considered as a divine language. 

 There was opposition to language change. 

 There was no description of actual language use. 

 

2. Behaviorism and Structuralism 

2.1 Background: Empiricism 

 Experience and Scientific Observation > The source of science should not be 

speculation. 

 Observable Data > The researcher must comment on things that are 

observable and visible. 
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 No Preconceptions or Introspection > The human mind should not be involved 

in the research process (Objective judgment) 

 Positivism > It was a kind of empiricism. 

 

2.2  Learning: Behaviorism 

 The whole Behaviorism > It was about stimulus (external event), response (a 

change in behavior) and reinforcement: S→ R↔ Reinfo 

 Associative Theories > Hunan mind is a blank slate (tabula rasa) at birth. 

 Patterns of Learning > Parrot Learning, Memorization, Habit Formation, 

Mechanical Learning. 

 Analogy > It emphasized learning through analogy rather than analysis, i.e., 

learners learn from similarities. 

 

2.2.1 Two Theories of Behaviorism 

 Pavolvian Classical/Respondent Conditioning > The stimulus elicits a 

response i.e. respondents are the influences created due to the reaction to the 

stimuli.  

 Skinnerian Operant Conditioning/Neobehaviorism > Response is emitted to 

make the environment show a reinforcement i.e. responses are operants that 

cause a reaction. 

 

2.3 Language: Structuralism 

 Surface Structure > Only observable things were investigated. 

 Descriptivism > It was against prescriptivism. 

 Structuralists > They believe that languages were systems made up of separate 

elements. 

 

3. Cognitivism and Nativism 

3.1 Background: Rationalism 

 Extrapolation and Inference > By applying logic and reason, they tried to 

discover the underlying motivations 

 Subjective Judgment > They were required to test their preconceptions and 

theories. 

 

3.2 Learning: Cognitivism 

 Meaningful Learning > Ausuble highlighted the role of mind and human 

cognition in learning. 
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 Subsumption > It is the process of relating new data to knowledge already 

existing in the mind. 

 Schemata > The elements of input should relate meaningfully to our 

knowledge base in our mind. 

 Retention > Learning will be more enduring. 

 Proactive Inhibition and Retroactive Inhibition > They are two drawbacks of 

rote learning according to Ausuble. 

 Systematic Forgetting > It is an intentional and purposeful way of forgetting 

through obliteration, also called cognitive pruning, leading to memorial 

reduction. 

 Automatization > In this process, the specific items are forgotten but the 

whole item is maintained. 

 Manufacturing Meaningfulness > It refers to inventing mnemonic devices to 

remember things. 

 Language Attrition > It is the gradual language loss. 

 Subtractive Bilingualism > L2 is dominant in ESL contexts (when a 

student learns a second language at the expense of their first language). 

 Additive Bilingualism > L1 has got prestige in EFL contexts (the 

second language is seen as an addition to the learner's first language 

rather than as a replacement for it). 

 Charles Osgoods’ Representational Mediation Theory > It was proposed to 

reconcile behaviorism with cognitivism, asserting that linguistic stimulus 

elicits meaning in the mind which is a covert self-stimulating mediating 

response, leading to an overt response. 

 

3.3 Language: Nativism, Innateness position 

 Competence (Langue) > It refers to decontextualized language knowledge in 

the mind of an ideal speaker/hearer (Idealization). 

 Performance (Parole) > It refers to the actual use of language in speech or 

writing in the real context. 

 The Theory of the Poverty of the Stimulus > Language acquisition is innately 

determined due to a God-given ability. 

 Innateness Position > The innate capacity is predisposed in a black box, called 

language acquisition device (LAD). 

 Three Adequacies of a Sound Theory >  

1. Observational (Grammatical judgement),  

2. Descriptive (Surface Structure),  

3. Explanatory (Deep Structure and Acquisition Mechanism). 
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 Pivot Grammar > It was a deficient theory referring to children’s mental 

knowledge → pivot class word + open class word 

 Universal Grammar > By generative rules, deep structure sentences are 

developed, while by transformational rules surface structures are developed.  

 Principles and Parameters Theory > Principles are common to all languages, 

while parameters vary among certain limits. 

 Core Grammar > It contains all the universal principles and parameters which 

can be set for particular languages (It is in the mind of the speaker). 

 Minimalism and Optimalism > Chomsky’s focus shifted from syntax to 

lexicon. 

 Main interference of Chomsky’s Theories  

 Connectionism > All the cells in the brain are connected to each other 

  Parallel Distributed Processing (PDP) > Our brain can process 

information in a parallel fashion and simultaneously and there is a 

tabula rasa but no UG. 

  Emergenticism > There are interactional patterns among cells and due 

to receiving input, the language ability gradually emerges. 

 Cognitive Linguistics > Language is not a separate faculty, syntax is 

the analysis power and competence and performance cannot be 

independent from each other. 

 

4. Constructivism, Post Structuralism 

4.1 Background:  Social Perspective 

 Qualitative Research > It requires ethnography and longitudinal studies 

including thick description and researcher involvement in a natural and social 

context. 

 

4.2  Learning: Constructivism, Sociocultural Perspective and Humanistic 

Psychology 

I. Constructivism > It refers to the individual construction of reality in a social 

context.  

 Cognitive Constructivism > According to Piaget, cognitive 

development occurs as a result of genetics and experience interaction, 

so that social context only triggers cognitive development.  

 Social Constructivism > According to Vygotsky, only social 

interaction but not genetic predisposition, triggers cognitive 

development. 
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II. Sociocultural Perspective > According to Vygotsky, language learning occurs 

as a result of mediation, meaningful imitation, private speech and 

internalization, so that there is no room for genetic predisposition in this 

regard. 

 Zone of Proximal Development (ZPD) > There is a distance between 

an individual’s actual cognitive capacity and the level of potential 

cognitive development, which can be removed through collaboration 

and scaffolding based on mediation theory (parent teaching a child 

how to ride a bike or a coach walking an athlete through how to throw 

a ball). 

III. Humanistic Psychology > According to Rogers, both affective and cognitive 

aspects should be deemed important in human learning, so that it rejects the 

transmission model of learning and emphasizes phenomenal and discovery 

learning via fostering learner autonomy and empowerment. 

 

4.3 Language: Functional and Pragmatic View 

 Functional View > Language is a means of social interaction. 

 Pragmatic View > Use of language matters rather than usage. 

 Interaction Hypothesis > Learners should get involved in negotiation of 

meaning, which encourages focus on form while they are acquiring a second 

language.  

 Noticing Hypothesis > Being against incidental learning, it highlights that a 

minimum amount of noticing is essential while receiving input so that it can 

turn into intake. 
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Mock Items 
 

 

1- Which of the following had an anti-mentalistic view?  

   1) Nativism 2) Constructivism 3) Positivism 4) Functionalism 

2- ………… is the distance between a child’s actual cognitive capacity and the level of 

potential development. It explains that a child can improve its actual cognition to his/her 

potential development through interaction with an adult who is cognitively more 

developed compared to him/her.  

   1) Representational mediating process 2) Zone of proximal development 

   3) Connectionism  4) Pivot grammar 

3-………… refers to the ability of a theory to provide an account of the formal 

properties of language and its surface structure.  

   1) Explanatory adequacy 2) Observational adequacy 

   3) Descriptive adequacy 4) The poverty of the stimulus 

4- He saw cognitive development as essentially a process of maturation, within which 

genetics and experience interact. This best represents ………… .  

1) the habit formation theory 2) cognitive constructivism 

3) parallel distributed processing 4) zone of proximal development 

5- All of the following were the features of the Grammar-Translation Method EXCEPT 

………… .  

   1) study of declensions and conjugations 2) rote learning of grammar rules 

   3) practicing writing sample sentences       4) monolingual texts and dialogues 

6- All of the following can be associated with behaviorism EXCEPT ………… .  

   1) stimulus and response 2) tabula rasa 

   3) verbatim learning  4) assimilation 

7- All of the following can be associated with humanistic psychology EXCEPT ……… .  

1) learner empowerment 

2) critical thinking 

3) encouraging learners to maintain the status quo 

4) phenomenal learning 

8- According to Ausubel, in behaviorism, ………… refers to forgetting an item in 

memory because of the interfering effect of similar rote materials learned immediately 

before the learning task.  

   1) proactive inhibition 2) cognitive pruning 

   3) retroactive inhibition 4) obliterative forgetting 

9- Which of the following was a criticism addressed to Chomsky’s theories?  

   1) The functional view 2) Emergentism 

   3) Behaviorism  4) Universalism 


